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1. Overview of CIF Data Importer

The CIF data importer is a tool available in the RSC Word
templates for authors to import crystallographic structure data
from a CIF file as a formatted table or footnote.

Automating this task will save authors time and effort, and
also reduce the opportunity for copying errors to be
introduced.

It is currently only available for Word 2003/2004 operated
on a PC. Problems may occur when running the tool on a
Macintosh computer.

Please note that the CIF Data Importer is currently a Beta
version for testing, and the RSC would welcome feedback by
users that might improve it.

2. How to download and install the Word author
templates

These are the steps that need to be performed before using
the latest Microsoft Word author templates for the first time.
We assume that the templates are being used on a PC (rather
than a Macintosh) and the Microsoft Word version is
2003/2004.

1 Download the appropriate template zip file from the
Microsoft Word Templates page of the RSC website to
your computer and unzip it if necessary.

2 Decide which template to install — if you arre using a PC
and wish to use the CIF Data Importer then choose a

RSC W2003 XXX CIF 32.dot template (rather than a
RSC W2003 XXX 32.dot template, which are for those
using Macintosh computers whch do not contain the CIF
Data importer). XXX determines whether you are writing
a communication, article or report.

3 Insert the template ‘.dot’ file into your Word templates
folder. If you are unsure where this is then open Word,
look in the Tools menu, choose Options and view the File
Locations tab to find the path to your User Templates
directory. It is into here that you need to move the relevant
template ‘.dot’ file to.

4 Ensure that macros are enabled in Word - the macros that
are embedded in the RSC template are there to help you
and are not in any way dangerous. Go to the Tools menu,
choose Macro, then Security... and ensure that it is set to
Medium (under the Security Level tab). If not then click on
that option to select it. You will need to exit and reopen
Word for your changes to be applied.

5 To start writing a new article or communication or report
with the guidance of the relevant template and RSC
toolbar, open Word then, from the File menu and New
window, select the relevant RSC template and open a new
file (as with any other Word template).

3. How to run the CIF Data Importer

Follow these steps to insert a table or footnote containing
data imported from a CIF file, once the relevant Microsoft
Word author templates have been installed and used to start
writing a new document.

1 Check that your CIF file is formatted correctly. You may
wish to wuse checking software from the CCDC
http://www.ccdc.cam.ac.uk/free_services/encifer/

2 Position the cursor in the Word document at the point
where the data is to be inserted.

3 Click the 'CIF Data Importer’ button in the RSC toolbar at
the bottom of the Word window.
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4 You will be presented with a dialog box to browse to the
location of the CIF file(s) to import and select it for
import. Note that while multiple .cif or .txt files can be
selected for import, when submitting to the RSC it is
preferred that the data for all structures is collated into a
single .cif file.

5 Click the 'CIF Data Importer’ button in the RSC toolbar at
the bottom of the Word window.
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6 You will then be asked which structures in the CIF file
you wish to import. Note that while a maximum of 20
structures can be imported that a table containing more
than 10 structures starts to look cluttered. It is also
possible to reorder them if their order in the CIF file is not
the order that you wish to present them in.

Select structures {and order) k x|

Narne in CIF file | CCDC Mumber | Chemical Formula

data_2Me CCDC 663956 37 H4G WS

[ data_tMesrz CCDC 663954 C37 H4T WS, 2(Br)

[ data_tMelz CCDC 663955 C37 H4T WS, C H cls, 0L67(C H CI3), 2(1)

data_3BrBr CCDC 883957 C35 He1 Brz NS Mi, (C He iz}

data_5 CCDC 653961 C41 H49 Fh WS Mi OF 52, 2(C4 HE O)

[ data_smeagiz CCDC 663958 37 H48 Br NS Mi, 0,5(802 14)

dats_6Mengsls CCDC 663962 C74 HI0 W10 A2, 2(C4 H10 ), Ags 18

data_3MeoTF CCDC 663959 C37 H45 Br NS Mi, CF3 035

D data_3PFE CCOC 663960 T35 H41 Br WS Mi, FE P

O data_sMeaTez CCDC 663963 74 Han Agz M10, 2(C4 HE 0), 2(C F3 03 5)

O data_7 CCDC 663964 37 He7 5 i (C4 H10 @)

d [

Deselect Al Selected row;  Deselect | Mave Up | |
O Cancel |

7 If you wish the data to be displayed with an alternative

name to the default (taken from the CIF file) then it is
possible to type it in the following dialog box.

8 The final dialog box defines which properties from the
CIF file you wish to import (and the CIF labels that
correspond to them). Note that properties in bold are
required and should not be removed from the output.

Select properties (and order) to import 3 i x|

i{Properties in bold are required - do not deselect)

Propert

| Labelin CIF file

Chemical formula (moiety)

O chemical formula fsum)
Formula Mass

Crystal system

A

7L

Fh

alpha/degrees
beta/degrees
amma/degrees

nit cell volume,;/ 43
emperature,K

Space group

No. of formula unit in unit cell, 2
[ radistion type

[ absorption coefficient, mufmm-1
la. of reflections measured

0. of independent reflections
ink

A Final 1 values (1 > Zsigma(l))
Final wR2 values (1 > 2sigma(l))
inal R1 walues {all data)

Final wR2 values (all data)

[ Goodness of fit on F2

[ Flack parameter

O rogers parameter

O cooc number

_chemical_Formula_moiety
_chemical_Farmula_sum
_chemical_Formula_weight
_symmetry_cell_setting
_rell_length_a

_cell_length_b

_cell_length_c
_cell_angle_alpha
_cell_angle_beta
_cell_angle_gamma
_cel_volume
_cel_measurement_temperature
_symmetry _space_group_name_H-M
_cel_formuls_units_Z
_diffrn_radiation_type
_exptl_absorpt_coefficient_mu
_diffrn_reflns_number
_reflns_number_tatal
_diffrn_refins_av_R_equivalents

_refine_ls_P._factor_gt
_refine_ls_wr_Factor_gt
_refine_ls_R_factor_all
_refine_ls_wR_Factor_ref
_refine_ls_goodness_of_fit_ref
_refine_ls_abs_structure_Flack
_refine_ls_abs_structure_Rogers
_database_code_depnum_ccde_archive

Deselzct All | mote that we assume that *_refins_threshold_sxprassion” contains a value of “=2sigmally” or equivalent,

oK | Cancel

*  Once your table or footnote has been created you should
check it in Microsoft Word. You may wish to reformat
some parts of it e.g. add subscripts to the space group
names to make the screw axes clearer.

4. Information about CIF format required

Multiple CIF files can be selected for import if the
structures to be imported are not in a single file (although for
submission it would be preferred if these could be compiled
into a single CIF file). Files with extension .cif and .txt can be
selected for import.

Different crystal structures start with a line which starts
with ‘data ’ (with the exception of the ‘data_global’ and
‘data_publication_text’ lines) and end with ‘#==END’
(although if this label is missing the import will still work).
The suffix following ‘data ’ is taken to be the default name
for the structure (e.g. data_NamelnCIFfile), but an alternative
name can be input if desired.

The following properties are required for the crystallographic

data imported from the CIF file to be valid (the label from the

CIF file is given in brackets):

* Chemical formula (_chemical formula moiety  or
_chemical formula_sum)

* Formula Mass (_chemical formula_weight)

*  Crystal system (_symmetry_cell_setting)

e alA (_cell length_a)

s b/A (_cell length_b)

e c/A (_cell length _c)

* a/°(_cell angle alpha)
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e p/° (_cell angle beta)
* 9/°(_cell angle gamma)
*  Unit cell volume/A (_cell volume)
*  Temperature/K (_cell measurement temperature)
* Space group (_symmetry space group name H-M or
_space_group name_H-M_alf)
e No. of formula units per unit cell, Z
(_cell formula_units Z7)
At least one of the following properties are required for the
crystallographic data imported from the CIF file to be valid:
¢ No. of reflections measured (_diffin_reflns_number)
* No. of independent reflections (_reflns_number_total)
R, (_diffrn_reflns_av_R_equivalents)
At least one of the following properties are required for the
crystallographic data imported from the CIF file to be valid
(note that we assume that ° reflns threshold expression’
contains a value of “>2sigma(l)’ or equivalent):
* Final R, values (I > 20(])) (_refine_Is R factor gt)
*  Final wR(F?) values (I > 20(I)) (_refine_Is wR_factor_gt)
* Final R, values (all data) (_refine Is R factor all)
*  Final wR(F?) values (all data) (_refine_Is wR_factor_ref)
The following properties can optionally be added:
*  Absorption coefficient, /mm (_exptl_absorpt_coefficient_mu)
* Radiation type (_diffrn_radiation_type)
+  Goodness of fit on F (_refine_Is_goodness_of fit_ref)
* Rogers parameter (_refine_Is_abs_structure_Rogers)
* CCDC number (_database_code_depnum_ccdc_archive)
In general, the appropriate property values are simply
extracted from the CIF file and inserted into the article with
no processing. However, the following exceptions apply:
e Chemical formula (from the chemical formula moiety or
_chemical formula sum) has:
* spaces removed from it
* commas replaced by the special character ¢
* numbers which don’t immediately preceed an open
bracket ( or [ character are turned into subscripts
* Radiation type: the string ‘\a’ is replaced by ‘a’
* Space groups: non-numeric characters are italicised,
spaces are deleted, and the following substitutions applied:
» -1is converted into T
* -3 is converted into 3
* -4 is converted into 4
* -6 is converted into 6

5. Further information

About RSC Microsoft Word templates:

http://www.rsc.org/Publishing/Journals/guidelines/AuthorG
uidelines/AuthoringTools/Templates/word.asp
About the CCDC checking tool encipher:
http://www.ccdc.cam.ac.uk/free_services/encifer/

6. Examples of formatted data

An example of data imported and formatted as a footnote is:

“Crystal data for la: C;,H4CI,N,, M = 257.15, triclinic, a =
6.5705(11) A, b = 7.6756(14) A, ¢ = 12.6098(18) A, o =
85.165(13)°, f=76.785(13)°, y = 73.868(16)°, V' =594.58(17)
A®, T =120(2) K, space group PT, Z =2, u(MoKa) = 0.519

mm”', 14508 reflections measured, 3452 independent
reflections (R;,, = 0.0107). The final R; values were 0.0218 (/
> 20(I)). The final wR(F?) values were 0.0708 (I > 20(I)). The
final R, values were 0.0243 (all data). The final wR(F>) values
were 0.0734 (all data). The goodness of fit on F? was 1.115.
CCDC number CCDC 618057. Crystal data for 1b:
C12H14C12N2, M = 25715, triclinic, a = 43029(9) A, b =
5.7033(9) A, ¢ = 12.6098(18) A, a = 100.859(13)°, B =
95.703(13)°, y = 99.229(11)°, ¥ =297.29(9) A®, T=120(2) K,
space group P1, Z = 1, w(MoKa) = 0.519 mm™, 7056
reflections measured, 1721 independent reflections (R;,, =
0.0097). The final R; values were 0.0322 (I > 20([)). The final
WR(F?) values were 0.0906 (I > 20(I)). The final R, values
were 0.0328 (all data). The final wR(F?) values were 0.0912
(all data). The goodness of fit on F* was 1.068. CCDC number
CCDC 618059. Crystal data for 2: C,H,CL,N,, M = 257.15,
orthorhombic, a = 27.4793(11) A, b = 6.0280(3) A, ¢ =
7.3190(3) A, a = 90.00°, B = 90.00°, y = 90.00°, V =
1212.36(9) A®, T = 120(2) K, space group Pbcn, Z = 4,
w(MoKa) = 0.509 mm™', 37294 reflections measured, 1776
independent reflections (R;,; = 0.0162). The final R; values
were 0.0249 (I > 20(I)). The final wR(F?) values were 0.0785
(I > 20(1)). The final R; values were 0.0294 (all data). The
final wR(F?) values were 0.0807 (all data). The goodness of fit
on F* was 1.059. CCDC number CCDC 618061.




An example of data imported and formatted as a table is:

Table XX Caption

Compound reference 2Me 3BrBr 5 6MeAg6I8 3MeOTf
Chemical formula C37H45N5 C35H41Br2N5Ni‘(CH2Clz) C41H49F6N5Ni07s2'2(C4H30)C74H90N1oAgz'Z(C4H100)'Ag518C37H45BI'N5Ni'CF303S
Formula Mass 559.78 835.18 1104.89 3145.96 847.47
Crystal system Monoclinic  Triclinic Monoclinic Monoclinic Triclinic
a/A 15.058(3)  12.7728(5) 22.7194(19) 13.6353(4) 8.6147(3)
b/A 24.920(6)  13.6700(5) 25.51003) 22.1211(6) 14.2268(7)
c/lA 10.967(3)  25.2292(10) 14.1716(13) 17.0640(5) 16.2224(8)
al® 90.00 87.286(2) 90.00 90.00 101.802(2)
pl° 91.360(3)  75.428(2) 125.520(4) 98.0900(10) 98.787(3)
y/° 90.00 71.776(2) 90.00 90.00 96.327(3)
Unit cell volume/A® 4114.2(17) 4047.2(3) 6685.2(11) 5095.8(3) 1902.67(15)
Temperature/K 120(2) 120(2) 120(2) 120(2) 120(2)
Space group P21/c P1 C2/c P21/n P1

No. of formula units per unit 4 4 4 2 2

cell, Z

Radiation type Synchrotron MoKa MoKa MoKa MoKa
Absorption coefficient, x/mm™ 0.054 2.616 0.415 3.972 1.673

No. of reflections measured 22457 69924 28442 78859 27224

No. of independent reflections 5879 18589 7590 11729 6686

Rin 0.0579 0.1227 0.0715 0.0516 0.1479
Final R, values (I > 20(1)) 0.0700 0.0900 0.0869 0.0560 0.1050
Final wR(F?) values (I > 2a()) 0.1937 0.1668 0.1959 0.1026 0.1744
Final R, values (all data) 0.1048 0.1837 0.1390 0.0753 0.1853
Final wR(F?) values (all data) 0.2125 0.1947 0.2181 0.1121 0.2085
Goodness of fit on F* 0.976 1.008 1.056 1.166 1.126

Flack parameter

Rogers parameter

CCDC number CCDC CCDC 663957 CCDC 663961 CCDC 663962 CCDC 663959
663956
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